
Poster Photoshop Workshop Manual 
By Bart Saris on account of DIAFRAGMA 

This manual is courtesy of DIAFRAGMA©, and will cover all the steps explained during 
DIAFRAGMA’s Poster Photoshop Workshop on the 18th of March 2019. Before we start with 
the step-by-step walkthrough, be sure you are seated at a computer with Photoshop 
installed on, and one with a usable mouse. Start up your computer in Windows 10 and have 
fun with the workshop! 
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Opening Photoshop 
Photoshop can be found with the search function in Windows 10. 

- In the search bar, simply type Photoshop, and open Photoshop CS6© 

Photoshop Mainframe 
Opening Photoshop will get you into the mainframe, which will look something like beneath.  

 
In the mainframe, there are a few things to be noted: 
 

1. Main program 
○ In the top of the program are the program tabs “File”, “Edit”, and so on. We 

will later on use these tabs throughout the manual for e.g. loading in pictures 
and creating new layers.  

2. Toolbar 
○ On the left in the program, the toolbar can be found. Here you can find all the 

main photoshopping tools, such as the selection tool and the painting tool.  
3. Option bar 

○ When using a tool, the options bar appears on top (beneath the main program 
bar), with all options for the selected tool (e.g. changing shapes, sizes and 
opacity). 

4. Manager 
○ In the right you can find the manager panels. In these panels you can manage 

your objects and corrections and such. The most important manager panel 
will be the “Layers” panel, in which we will later on manage all the added 
layers.  

Importing a picture file 
What is the first thing to do when you start Photoshopping? Of course, loading in a picture to 
be Photoshopped. ​NO​. Let me stop you there. The very first thing to do when starting to 
Photoshop, and the most important thing to do while Photoshopping is to ​think​. Think about 
what you want to accomplish. What is your creative idea, and how are you going to 
implement your idea into a beautiful poster. 
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Let us start by thinking about whether we want to start creating our poster from a blank 
canvas, or do we want to use the original poster as a canvas. Sometimes it is easy to 
recreate the background of the poster, and thus recreate the poster from scratch. But too 
often this will not be possible, thus you will have to use the original poster as your starting 
point and start adding your pictures shot, and own texts, to this original poster. 
When you have had a good think about how to proceed, we can start by opening the canvas. 

Opening a file 
● Select the file to open by either 

○ Files → Open.. 
○ Ctrl+O.  
○ Dragging the file in the empty Photoshop program 

When you want to work with a blank canvas, also open the original poster the same way. 
Anyhow, you also want to create a new blank file. This can be done in multiple ways. 

Opening a new project 
● You can create a blank canvas either by 

○ Files → New.. →  
○ Here you can create a new canvas by manually providing the dimensions, or 

selecting one of the pre-produced dimensions (such as A4, A3 and so one). 
● Perhaps an easier way to create a blank canvas the same size as your original 

poster is by doing the following: 
○ Select your opened original poster entirely by: 

■ Ctrl+A 
■ Using the selection tool and select the entire poster 
■ Main program: Select → All 

○ Copy the selected poster by using: 
■ Ctrl+C 
■ Edit → Copy 

○ And then create a new file by: 
■ Ctrl+N 
■ File → New 

You can now see that the dimensions of your original poster file are used in creating a new 
file with the same dimensions. Create the new file. You can then paste your file in the newly 
created file if you want to use the file as an example. A new layer is created in the Layers 
panel, and you can unshow this layer by either pressing the Eye pictogram, or by setting the 
opacity to 0.  
Saving the project can be also be done in the Files bar, or by using Ctrl+S​. Be sure to 
save your progress often.  

Opening your own pictures and Ctrl+z 
The thing to do next, is opening your recently shot pictures that you will use in recreating the 
original poster.  

● Open the pictures the same way as you opened the original picture. Your pictures will 
then be opened in again a new tab/window in the program.  

○ Is every of your pictures opened in the program? Then let us begin the fun!  
Ow WAIT. Before we start with the fun parts, take in mind that whenever you do something 
stupid or horrible you can always go back to where you were using the command​ Ctrl+Z ​and 
going multiple steps back can be done with ​Alt+Ctrl+Z. 
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Selecting 
There are multiple tools that have the ability to select parts of your photo, we will go through 
them step-by-step. We will cover the main tools and their ​brother functions​ which can be 
called upon by selecting and then dragging your mouse over the little tab-expansion triangle 
in the lower right corner of each tool tab. In this walkthrough, behind each tool will be the 
shortcode to use this tool. Simply pressing this button will grant you access to that particular 
tool. ​Deselecting​ can be done by using Ctrl+D or clicking anywhere with the Rectangular 
Marquee. ​Inverting​ your selection can be done by using Shift+Ctrl+I (or in the Select tab).  

The Move tool (V) 
● The Move tool is your cursor, with this tool you can drag elements in your creation. 

We won’t use the brother function to the Move tool, so I am simply not going to 
explain that. 

The Rectangular Marquee (M) 
● The Rectangular selection tool can be used when you want to select or delete certain 

parts of your image with a straight border or when you want to select a certain new 
part of your picture/poster to create a picture with altered dimensions (for example a 
smaller sub-part of your photo/picture).  

● Using Shift while using this function will grant you the power of selecting exact 
squares, i.e. Shift locks the dimensions of the selection tools to be equal. The brother 
functions to the Rectangular Marquee are: 

○ The Elliptical Marquee (M) (used to select circular or elliptical parts of your 
picture). Using Shift to this function will give you the option to select perfect 
circles. 

○ Single Column and Row Marquees can be used in selecting rows, but we 
won’t use them. 

4 



The Lasso (L)  
● The Lasso tool can be used if you want to select things freely, i.e. out of the loose 

wrist. This function on its own is very hard to use if you only have a mouse, and not a 
touch screen drawing board to your computer.  

● Anyhow, you can use this tool to make free selections of parts of pictures. The 
brother functions to the Lasso are the Polygonal Lasso (used in selecting polygons) 
and the very interesting Magnetic Lasso. 

○ The Magnetic Lasso can be a very useful tool if you want to select for 
example a person out of a picture. The Magnetic Lasso can be used the same 
as a Lasso, freely, but it sticks to the lines of color change, in that way the 
Magnetic Lasso enables you to easily select hardlined/outlined figures from a 
picture.  

The Quick Selection tool (W) 
● The Quick Selection tool can also be very useful when you want to select certain 

objects from a picture. The Quick Selection tool, as well as the brother function Magic 
Wand (not to be confused with the Hitachi Magic Wand, which has another purpose 
and function) can detect (color)structures in the picture and select all adjacent parts 
of the picture with similar structure.  

● When using the Quick Selection tool, hold the mouse and simply drag around to 
select particular structures. The same can be done by using the wand, and using 
Shift after selecting one structure to select another structure. This way you can select 
multiple defined structures from your picture at one. 

 
You will now face the hard test of carefully selecting the persons in need of selecting, either 
using the Magnetic Lasso tool or one of the Quick Selection tool. Note that you can change 
the settings on ​tolerance ​off the selection in the ​Option bars​ of these tools.  
By changing the tolerance, you enable yourself to select even more precise. When you have 
selected the desired part of the picture, you can simply copy paste it on the poster or on the 
blank canvas and a new layer will be created with the new object in it. 

Transformation 
Now you might encounter that the picture is much smaller or larger than you desire. We can 
change the position, dimensions and scale of an object by either 

● Pressing Ctrl+T 
● Edit → Either one of the transformation tabs (free for free transformation, the other 

ones for predefined transformations) 
You can now scale the object to the desired size. Holding Shift will again grant you the 
power of keeping the ratios of the dimensions, so that your object doesn’t become too skinny 
or fat. 
 
You can now either repeat these steps for the possible other objects in your poster, or you 
will want to adjust this first new object in a way to make everything look way better. 
Whatever you do, always work in ​different layers​, and be sure to -before changing anything 
to your picture- ​duplicate your layer (by right clicking on the layer and choosing 
“Duplicate Layer”). ​This way you will always have the original layer to fall back to in case 
everything went horribly wrong.  
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Tonal Adjustments 
So there are a couple types of adjustments you can do to your image, all these can be found 
under the main tab “Image”. In this tab you can find corrections on colors, brightness, 
contrast and so on. I won’t explain them all to you but you also won’t need them all. Just 
start puzzling with them until you are content with the result. Another thing to do is to open 
the adjustment tab by going to ​“Window” → “Adjustments”​, with the adjustments panel 
you can change the settings over all the layers in the project, which might come in handy in 
the end. There are a few adjustments I will further specify: 

Brightness/Contrast 

● Brightness and Contrast make adjustments to the tonal range of your image, 
adjusting highlights and shadows respectively. 

Levels, Curves (and Exposure) 

● Levels modify the tonal values by combining adjustments in shadows, midtones and 
highlights. By slightly changing the separate levels, your image can become much 
more vivid. That is also why this adjustment layer is one of the most used ones in 
Photoshop.  

● With curves the same can be done but much more precisely, creating perfect 
balances in tones of your picture.  

● With the exposure tab, the same can be done but separately so, with Exposure 
adjusting the highlights, Offset adjusting the midtones and Gamma adjusting the dark 
tones only 

Vibrance and Hue/Saturation 

● With the Vibrance tab you can adjust the image in two ways. The saturation slider 
increases saturation of the colors in the image. The Vibrance slider modifies the level 
of saturation of all colors selectively, focussing on the least saturated colors and 
avoiding over-saturation of skin tones, adding liveliness to your picture. 

● Hue/Saturation lets you adjust the hue, saturation and lightness of your entire image 
or in a specific range of colors in your image. Just play a bit with these siders and 
look whether you can create a more fitting picture.  

Color Balance 

● The color balance tab lets you change the mixture of colors in an image. By changing 
the color mixture composition, you can bring out certain colors real beautifully.  

Black & White 

● And last but not least (we strive for equality), Black & White. In this panel you can 
change the picture into a Black & White picture, whereafter you can adjust what 
colors you want to bring out extra in your conversion to Black & White. 

 
So these were a few of the many adjustments you can do on your picture, to increase the 
reality of the fit with the background and the fit in the poster. Tonal adjustments can really 
make the difference between a realistic remake, and a really ugly one. 
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Retouching 
Maybe one of the most interesting things to learn, and one of the things I most often use is 
the art of retouching, or spiriting away things (gotta love Ghibli). There are a few tools in the 
retouching kit that can be very helpful when you struggle with the discovery that the picture 
you took does not fully cover the object in the poster. We will again not explain all the tools, 
but only the ones most often used and most valuable to our adventure. Before explaining the 
tools be very secure in the way you work. ​Duplicate the layer you want to retouch first, 
by right clicking on the layer and choosing “Duplicate Layer”, and know when to use 
Ctrl+z. ​Take note that the a part of the Option bar functions (Shape, Size, Hardness, and so 
on) can also be quick-summoned by using a tool and the left clicking anywhere in your 
project. 

The Eraser (E) 

● This may seem unnecessary to explain, but the eraser tool can be very valuable in 
retouching the final parts of a picture with which you are not very content. Changing 
the opacity of the eraser (in the Option Bar) can give the option to create a smooth 
blurry transition between the poster’s background and a pasted in picture.  

● There is one particular interesting brother function to the eraser, which is called the 
Background Eraser: 

○ The Background Eraser, as it states, enables you to remove an entire 
background with about the same color set as the pixel you erase. This tool 
can be very useful in deleting for example the white background behind 
cartoon images, or the even-colored background wall to a close up facial 
picture. Nice tricks Mr Aizawa. 

Clone Stamp (S) 

● Probably the most useful trick there is to know in Photoshopping a poster, is the 
Clone Stamp tool. This tool lends you the power of imitating surrounding patterns and 
with that recreate that pattern elsewhere in the picture. This is my favourite “Sjoemel” 
tool. Spiriting away every part of the poster still visible after pasting your pictures on it 
by simply recreating the pattern of the surrounding background.  

● To use this tool simply use the Alt-key to select the pattern you want to imitate, and 
then click wherever you want to recreate this pattern. Be creative in using this tool. 
Play with the opacity and the size of the stamp to create a more natural result. Often 
you also want to mimic a part of the poster onto another layer, you can them simple 
use the Alt+Left Click on the poster layer and then switch to the layer you want to 
mimic the parts of the poster on.  

 

An additional Retouching tip from me: 
 
Using the Clone Stamp too much can create smudges in the stamped background. 
You can resolve this problem by first selecting (this can just be done freely with the 
Lasso) a small part of the neighbouring pattern you want to simulate, and copy this 
entire selected part onto the part you want to cover. Using the Clone Stamp to blur 
the edges can create a more realistic looking result. 
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Okay, these were the Retouching tools I wanted to cover, there are a lot more -try them out 
yourself- but these were the ones I myself use the most.  

Drawing and type tools 
The drawing and typing tools can be used, amongst others, to add text and shapes to your 
project.  

Horizontal Typing tool (T)  
● The Horizontal Typing tool can be used to create texts for your poster. In creating 

texts there are a few panels that need explanation and are good to know. 
○ When you have created a text, you can change the font and size and such in 

the option bar that appeared on the top of the program when you selected the 
text tool. 

○ You can do all sorts of text editing in the text-editing panel. If this panel is not 
yet opened in your manager bar, you can open it by going to “Window” → 
“Character” 

○ You can do all sort of text transformations by double clicking on the text layer. 
This will grant you access to the layer styles in which you can add colors, 
gradients, outer lines and so on, to the text. ​P.s. this can also be used in for 
other kinds of layers such as shape layers. 

In poster text editing it is also of great importance to recreate the font of the poster. The font 
is the layout of the style of the letters that is used. You can try and look for a font in the basic 
fonts, or you can search the InterWebs for any type of font that is used in your poster.  
For example: Search Google for “Font Christopher Robin” and you will see that there are 
multiple sites on which you can download fonts (for example ​www.dafontfree.io​). Here you 
can download fonts, after which you will have to install them on your PC.​ I’m not certain this 
can be done on the uni-computers, but we will see.  
Installing can be done by opening the downloaded file and clicking the admin-function 
“Install” on top of the opened font page. The font is then added to all your programs, so also 
to PhotoShop. You might have to restart PhotoShop, so be sure to ​save ​your progress.  

Rectangle tool (U)  

● The Rectangle tool can be used in creating rectangle shaped shapes, in the brother 
functions multiple other shapes can be selected such as rounded rectangles, 
ellipses, polygons, lines and custom shapes. You can select even more shapes by 
choosing a shape in the option bar of this latter brother function.  

● As with the text tool, you can change the effects on the shape by adding them in the 
layer styles (under Layer, or by double clicking on the specific layer). 

 
So this actually were all the Drawing and type tools I wanted to show you and with that we 
are almost at the end of this manual.  

Navigation tools 
In editing you sometimes want to zoom in on certain parts of the poster in order to also cover 
the small details.  

● You can do this by using the Zoom tool (Z) and then click on the part you want to 
zoom in on. You can unzoom by using the Zoom tool with Alt and then click.  
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● Furthermore, the Hand tool (H).  When you are zoomed in, you can stroll through 
your poster by using the Hand tool. With this tool you can grab your poster by clicking 
and stroll through it by dragging.  

 
That were all the tools I wanted to show you. Now I hope that you have enough knowledge 
to create a beautiful poster. The only thing that last you know is to save the project and 
export your poster. 

Saving and exporting 
You can save and export your project and poster in the Files tab.  

● Saving the project can be done by “Files” → “Save”, and save your project as a 
PhotoShop file.  

● Exporting the project can be done by “Files” → “Export” → “Export as…”. Here you 
can select the format you want to export to (either choose .png or .jpeg) and where 
you want to export it to. You can also change some additional options, but these are 
not really important for now. 

 
Then we are done. I hope that you have learned a lot and thought this all was useful. I hope 
you are content with the result, and have become to understand and like photoshopping. I 
want to thank you for your attending and attention. DIAFRAGMA wishes you well.  
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